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Like all CATIA products, CADAM Drafting requires a valid software license before the 
application can be run. In the simplest configuration, a software license can be tied, or 
nodelocked to a specific machine. Larger installations of CADAM Drafting will typically want to 
implement a concurrent licensing scheme. With concurrent licensing, a server manages a 
fixed number of licenses, handing them out to client workstations as they are requested. 
IBM's License Use Management (LUM) is required on UNIX and Microsoft Windows platforms 
to access and manage licenses for all CATIA products, including CADAM Drafting. 

This document will illustrate the four most common licensing configurations. The information 
presented here should be augmented with information found in the LUM documentation or on 
the LUM website. 
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1. Obtaining LUM
Dassault Systemes currently recommends that you download the latest version of LUM V4 to 
manage CADAM Drafting licenses. (For CATIA V5, LUM is provided on a separate CDROM that you 
received with your CATIA V5 software. You might still want to check the LUM website to see if there 
is a later version available. However, if you do download a later version, please verify that it has 
been certified for use with CATIA V5 before installing it. If it has not, use the version that you 
received with your CATIA V5 software.) The latest version of LUM (V4.6.8, as of this writing) for all 
supported CADAM Drafting platforms may be obtained, at no charge, from the IBM LUM website: 
http://www-306.ibm.com/software/awdtools/lum/support.html. The actual LUM software and FixPacks can be 
found under the Download “IBM LUM v5 and v4 products download” link on this page. Product 
Documentation can also be found on this page. We recommend downloading the documentation and 
reading it before proceeding with the actual installation. 

Customers who already have LUM V4.5.8 through V4.6.4 implemented may continue to use 
these versions of LUM with CADAM Drafting. However, versions of LUM older than 4.6.5 are 



no longer recommended, as they are not supported by IBM. Also, keep in mind that the 
newer versions of LUM (V4.6.5 and above) not only offer better code stability, but also offer 
desirable features. 

LUM license server minimum release level requirements:

 A minimum level of 4.5.5 is required on UNIX LUM servers

 A minimum level of 4.5.8 is required on Windows 2000 Professional LUM servers

 A minimum level of 4.6.2 is required on Windows 2000 Server and Advanced Server 
LUM servers

 A minimum level of 4.6.4 is required on Windows XP LUM server

 A minimum level of 4.6.7 is required on Windows 2003 LUM server

 A minimum level of 4.6.5 is required when High Availability Licensing (HAL) is used

 A minimum level of 4.6.7 is required when concurrent offline licensing is used

Note: LUM 4.6.8 + FixPack 4.6.8.13  is the current level certified by Dassault Systemes.  It is 
recommended to update your LUM servers to this level, especially if the license clients are 
running Vista or Windows 7.

Note for users of older CADAM Drafting Releases

If you are upgrading from an older V4 release of CADAM Drafting, and if you had 
previously been using EZ-LoK to manage licenses, it is important that EZ-LoK be 
uninstalled and removed from the system. Conflicts may develop if EZ-LoK and LUM 
are installed on the same system since they share some common directories and 
filenames. 

2. Using LUM in a Nodelocked Configuration on Windows
Note: CADAM Drafting V4 and CADAM Drafting for V5 cannot be configured to run on a 
Windows 98 client using Nodelocked licensing. If you want to run CADAM Drafting on a 
Windows 98 client, you must run with a license server and configure the Windows 98 PC to be 
a LUM client. (See the next 2 sections for more information.) 

 Install LUM on your PC: 

If you have access to the i4target.exe utility, you can skip this step.  Otherwise, the 
file arkwinxxx.exe (where "xxx" is the version of LUM you are installing), which you 
downloaded from the IBM FTP Site, is a self-extracting executable that contains all of 
the LUM installation files. For V4.6.8, this file is about 30 Mb. Once you copy this file 
to the PC, go to Explorer or File Manager, double-click on the file to start the 
installation. LUM's default directory destination is C:\ifor. Note that you must be 
logged on with administrator privileges to install LUM. 

 Find the PC's unique target ID and get your license from IBM 

If you installed LUM or borrowed the i4target.exe or i4tgid.exe utility from another 
system, you can now get the PC's unique target ID. Note that the PC must have a 
network card installed and must have TCP/IP installed and properly configured before 
you can get the target ID. (The network card does not need to be connected to a 
network.) 

If you have installed a current version of LUM (V4.6.x) you can get the PC's target ID, 
by simply double-clicking on the file C:\ifor\win\bin\i4tgtid.exe.  You will get a pop-up 
message giving the target ID. 

 For older versions of LUM, as well as the current versions, you can get the target ID from 
a DOS Shell. Go to the directory C:\ifor\win\bin and run:

i4target –O

The output of i4target should be similar to this sample screen:



  

  

Where bf8c06 is the machine's unique target-id and win32mac is the target type. 
This is the information required by IBM to issue the CCD licenses.

IBM can issue two kinds of Windows target-types, win32 for iFOR/LS and win32mac 
for LUM. Make sure you order win32mac licenses.

If your PC has more than one network card, the i4target command will return a win32 
target-id instead of a win32mac target-id. IBM will not generate a usable key if you 
give them this win32 target-id. Instead, you must specify a specific network card 
when running the i4target command. To do this, first use the ipconfig command to get 
the name of the active network card.  For example, if you are using a Token Ring 
card, the name might be "IBMTRP3". In this case, you would run the i4target 
command as follows: 

i4target -d IBMTRP3

Now run the "i4target -O" command again and it will return a valid win32mac target-id 
based on the card you specified in the previous command.

Laptops accessing a license server via a docking station could have a problem getting 
a win32mac target-id, if a network card is later added to run CCD off-line using a 
nodelock key. If LUM is first configured on the laptop (without a network card) to 
access the network through the docking station, LUM will store the docking station 
network information. If you undock the laptop, LUM will try to access the docking 
station's network card and not the laptop's network card. LUM will display a target-id, 
but it will be a win32 target instead of win32mac. This is because the target-id is not 
based on a network card. To force LUM to use the laptop's network card do the 
following:

From a DOS shell type: 

net config workstation

This command should return something similar to: 

    Computer name             \\PC0239
    Full Computer name        My-computer
    User name                 Bob

    Workstation active on NetbiosSmb (000000000000)
    NetBT_Tcpip_{7576D9AD-6FF0-4CBA-888E-0530DC213281} (00105A8B3254)

Identify the network device that corresponds to the network card of the laptop. Copy 
the GUID (this is the number between the braces {} including the braces). Then run 
i4target -d GUID. For the above example it will be:



I4target -d {7576D9AD-6FF0-4CBA-888E-0530DC213281}

Now, "i4target -O" should return a valid win32mac target-id for the laptop's network 
card. This is the information that LUM will start using whether the laptop is docked or 
undocked. 

Some installations may need to be aware of LUM's TIMEOUT_FACTOR environment 
variable. In a complex network, or if you are using DHCP, you may experience long 
delays (30 seconds to one minute) while CCD attempts to obtain a license. One 
solution to this is to limit the time the license server spends looking throughout the 
network for other license servers. This is done by setting the TIMEOUT_FACTOR 
environment variable. Try setting this value to a value between 5 and 10 (seconds) to 
start with. If, after setting this value, your client machine reports that it cannot locate 
a license server, you will need to increase this time.   

 Create the nodelock file 

Once you receive the license information from IBM, you must create a file named 
nodelock (no file extension) in the folder: 

C:\ifor\ls\conf. 

Create this path, if it doesn’t already exist.  Make sure that all users logging on to the 
PC to run CCD have access to this folder and file.

When you receive the license information from IBM, via e-mail or fax, it may be in the 
following format for CADAM Drafting V4:

      -------------------------------------------------------------------
      Product name . . . . . . : CATIA.MECH V4 CCD WORKSTATIONS
      Product number . . . . . : 5626CCD
      Target type. . . . . . . : win32mac Target id. . . . : 5fc1a7f3
      No. of connections . . . : 1
      Password type. . . . . . : LICENSE License type . . : NODELOCKED
      License annotation . . . : CCDS410
      Passwords are valid From : 1998-04-07 To . . . . . . . : 1998-06-07
      Generated by userid. . . : US30054 Generated by sys : ALR-MENU
      Generation reference No. : 1998-04-08-16.33.57.742008
      Vendor name. . . . . . . : Dassault Systemes
      Vendor id. . . . . . . . : 5242378dbf8d.02.c0.09.c8.93.00.00.00
      Vendor Password. . . . . : mzvyrc2rjfvrw
      Product Password . . . . : jrripujd6vmaw27t6vq73986fadsdns
      Product Version  . . . . : 410
      -------------------------------------------------------------------
      

The nodelock file for the above target-id should only contain the vendor id, product 
password, annotation and product version.  Comment lines are allowed if they start 
with #. The following is an example of a nodelock for the above target-id:

      # Passwords are valid From : 1998-04-07 To 1998-06-07
     # Target type. . . . . . . : win32mac Target id. . . . : 5fc1a7f3
      5242378dbf8d.02.c0.09.c8.93.00.00.00 jrripujd6vmaw27t6vq73986fadsdns 
"CCDS410" "410"

For CADAM Drafting V5, you will receive a license certificate in the following form. 
You should have received this certificate in addition to the certificate for your 
CATIA V5 configuration.  

IMPORTANT:  Unlike other CATIA V5 add-on products, the CADAM 
Drafting add-on product requires a separate license certificate.

CORRECT FORMAT FOR CCD V5:  



   ------------------------------------------------------------------
      [LicenseCertificate]
      CheckSum=46DBDAE4338C964D36C772E89B57A570
      TimeStamp=937931962
      PasswordVersion=4
      VendorName=Dassault Systemes
      VendorPassword=mzvyrc2rjfvrw
      VendorID=5242378dbf8d.02.c0.09.c8.93.00.00.00
      ProductName=CCD-Catia CADAM Drafting for V5
      ProductID=2041
      ProductVersion=R1
      ProductPassword=3axwxncimv5buu73b3s8sihzreasani
      ProductAnnotation=1
      LicenseStyle=nodelock
      LicenseStartDate=09/20/1999
      LicenseDuration=62
      LicenseEndDate=11/20/1999
      LicenseCount=1
      MultiUseRules=
      RegistrationLevel=3
      TryAndBuy=No
      SoftStop=No
      TargetType=26
      TargetTypeName=MS Win-32 MAC
      TargetID=5fc1a7f3
      ExtendedTargetType=
      ExtendedTargetID=
      DerivedLicenseStyle=
      DerivedLicenseStartDate=
      DerivedLicenseEndDate=
      DerivedLicenseAggregateDuration=
      SerialNumber=
      Upgrade=
   ------------------------------------------------------------------

The following, is a sample of a single license certificate for a DR1 CATIA 
Configuration with CCD as an add-on product.  This license format is not 
supported and will not work for nodelock or concurrent keys.  The product 
annotation, highlighted in red, is a clue that the wrong certificate was generated.

INCORRECT FORMAT FOR CCD V5:
------------------------------------------------------------------

[LicenseCertificate]
CheckSum=01E6F31639EE47BA12744D11D90AC65F
TimeStamp=1210789047
PasswordVersion=7
VendorName=Dassault Systemes
VendorPassword=7in28abn73xws
VendorID=5242378dbf8d.02.c0.09.c8.93.00.00.00
ProductName=DR1-Catia Drafting 1 Config.
ProductID=2038
ProductVersion=TMPMCQF
ProductPassword=sm6n2vjzm8w76nfmbhw3beqjyrsh6wbse4j4ybsddsaa
ProductAnnotation=TMPMCQFAAAA-CCD
LicenseStyle=nodelocked
LicenseStartDate=05/13/2008
LicenseDuration=11
LicenseEndDate=05/23/2008
LicenseCount=1
MultiUseRules=
RegistrationLevel=3
TryAndBuy=No
SoftStop=No
TargetType=26
TargetTypeName=MS Win-32 MAC
TargetID=6da131ee
ExtendedTargetType=
ExtendedTargetID=



DerivedLicenseStyle=
DerivedLicenseStartDate=
DerivedLicenseEndDate=
DerivedLicenseAggregateDuration=
SerialNumber=TMPMCQFAAAA
Upgrade=No
------------------------------------------------------------------

You can use the CATNodelockMgt.exe supplied with CATIA V5 to create or add to an 
existing nodelock file.  The license certificate may be supplied by IBM as an 
attachment, but if not, it can be created using Notepad, Wordpad, or any other editor 
but make sure that no extra characters are inserted in the file. Give the file a ".lic" file 
name extension, as this is the default file extension CATNodelockMgt.exe looks for.  

IMPORTANT:  In order for CCD to work, you must copy the nodelock file to 
C:\Ifor\Ls\Conf.  Create this path, if it doesn’t already exist.

Sample nodelock file created from a license certificate:
    # 5691DR1 DR1-Catia Drafting 1 Conf, Expiration date: 1999-11-21
    5242378dbf8d.02.c0.09.c8.93.00.00.00 xz2zjman44v9ywv2jndwdkas9ngagns 
"TMPHFAAAAAA-" "TMPHFAA"
    #5691CCD-Catia CADAM Drafting for V5, Expiration date: 1999-11-20
    5242378dbf8d.02.c0.09.c8.93.00.00.00 3axwxncimv5buu73b3s8sihzreasani "1" "R1"
  

This is all that is required for CADAM Drafting to run on a nodelocked PC. You do not have to 
run the LUM's configuration utility to use the nodelock file. If you later configure the PC as a 
network license client, remember to rename/delete the nodelock file, as CCD will try to use it 
first before checking the network for a license server.

3. Concurrent Licensing with an AIX Server and Windows Clients

 Verify your AIX level and acquire your licenses

Identify the machine you will be using as a License Server. While logged in as 
superuser, run the command uname -m to get the machine's uname/target-id. 

Order the CCD concurrent/server licenses from IBM. These licenses are based on 
the machine's uname. In this case you will receive a certificate that appears 
similar to those shown in the previous section, except that the "License Type" or 
"LicenseStyle" will be listed as "concurrent" instead of "nodelocked" and the "No. 
of Concurrent users" or "LicenseCount" fields should show the number of 
concurrent licenses that you ordered. 

The currently supported versions of CADAM Drafting V4 require AIX 4.3.3 or 
above. The currently supported versions of CADAM Drafting V5R19 require AIX 
5.3. 

 Acquire the necessary LUM software 

We always recommend obtaining the latest version of LUM, as described at the 
beginning of this document, instead of using the version that was packaged with 
your version of AIX. (For AIX 4.3.3, the version of LUM that is packaged with AIX 
will be earlier than 4.5.8.) 

Obtain the Windows LUM software using the instructions at the beginning of this 
document. 

 Use SMIT to install LUM. From the installation media or directory you downloaded 
the LUM installation files to, select the following: 



ifor_ls.base
ifor_ls.libraries
ifor_ls.compat
ifor_ls.msg.en_US 

 Add the following path to the super user's .profile: 

/var/ifor

Exit and login again to allow changes to take effect.

 If the installation of LUM is successful, the next step is to run the Configuration 
Utility called i4cfg: 

Select to Configure License Server 

Select to Start Services at System Restart 

Note: There is no Exit button on the panels, you must click on the upper left corner 
and select close to save changes.

 Make sure that i4lmd is running to continue. If not, run i4cfg -start before 
continuing. 

 To add licenses, run the Basic License Tool by typing: i4blt

The following default license will be displayed:
                                                             Enrolled   Available
   Product                 Version    Vendor                 Licenses   Licenses
   LicensePower/iFOR test    1.0      LicensePower/ifor Test 10000      10000
   
  

Note: This test license is used by the i4tv utility, when it is run on the clients to check 
for available servers. Do not delete this license.

 Add CCD concurrent licenses:

Select Product

Enroll Product...

The name of this server should appear in the "Server Name" field. 

Click on Import and select the file containing the License Certificate you received 
from IBM or DS. The program looks for files with .lic extensions. You also have the 
option to manually enter the product, license and vendor information from the 
license file you ordered from IBM or DS.  

     This completes the installation and customization of the LUM server software on AIX. 

 The next step is to install the Windows client software.

o Note that, as of CADAM Drafting Version 4 Release 2.3 and CADAM Drafting 
for V5, you no longer need to install LUM on every client because these 
releases are provided with a "static bound" license DLL. In order to take 
advantage of this option, a license server needs to be configured and have 
the product licenses installed. LUM V4.5.5 or above must be installed on the 



license server for this option to work. Network communication between the 
clients and the server must be working properly. The LUM configuration utility 
on the server created a file called i4ls.ini.  

Look for i4ls.ini file on the Windows server in: “C:\Documents and 
Settings\All Users\Application Data\IBM\LUM.”  On Windows Vista or Windows 
7 in C:\ProgramData\IBM\LUM, on AIX in: /var/ifor and on HP-UX in: 
/opt/lum/ls/conf. Prior to Windows Vista, the i4ls.ini file must be copied to 
the “C:\Documents and Settings\All Users\ApplicationData\IBM\LUM” 
directory of all client PCs. (“Application Data” is a hidden folder).  On 
Windows Vista or Windows 7, the file needs to be copied to 
C:\ProgramData\IBM\LUM.  (ProgramData is a hidden folder - Create the IBM 
and LUM sub-folders if they don’t already exist).

The CADAM Drafting license module will use the information in the i4ls.ini file to 
locate the license server. Optionally, you can install LUM on one of the Windows client.  This 
is useful for the administrator to monitor license utilization and more. The following 
instructions cover the (optional) installation of LUM on the Windows client. 

           Note: LUM must be installed on the same drive that the OS is installed on.

 The network communication between the server and client must be operational in 
order to proceed. Make sure both machines can ping each other by hostname.

 Install the Windows LUM software as described in Step 1 of the "Using LUM in a 
Nodelocked Configuration on Windows" section.

 Once LUM is installed, run the Configuration Tool to configure the client:

Note:  If the client PC is running Windows Vista or Windows 7, you may 
need Administrator elevated rights in order to proceed.   See “Getting 
Administrator Rights” at the end of this document.

Click on Start > Programs > License Use Runtime and select Configuration 
Tool 

Configure as 

Select: 
Network 
License Client 

Direct Binding

Enter: 
hostname of 
server
Select: <<Add 

Close window and save

 Run the "LUM Test and Verification Tool" to verify that the client can find the server. 
From a DOS shell, run: \ifor\win\bin\i4tv 

The response should look similar to this sample screen:



Note:  The CATIA products do not support Central Registry License 
Servers.  Ignore the message “No servers found” returned by i4tv.

This completes the installation of LUM on the server and client, you may continue to 
the next step. If i4tv was not successful in finding the server, then go back and make 
sure that:

o The i4lmd daemon is running on the server.
o The network is up and both systems can ping each other.

 If i4tv finds the server and you have installed the CCD concurrent licenses on the 
server, you should be able to run CCD on the Windows client now. If CCD displays 
the message: "Product license not found. Running in demo mode", even though i4tv 
found the server, then the CCD licenses you installed on the server using i4blt may 
not be correct or the date/time on your systems may not be in sync.

4. Concurrent Licensing with a Windows Server and Windows Clients

Note: If your Windows server is running Windows 2000 or Windows Server 2003, 
Vista you should install LUM 4.6.8.13

                     A PC running Windows 98 or Windows 95 cannot be configured as a 
license server.

 Install LUM as described in Step 1 of the "Using LUM in a Nodelocked Configuration 
on Windows" section.

 Run i4target as described in Step 2 of the "Using LUM in a Nodelocked Configuration 
on Windows" section and obtain your licenses from IBM. In this case you will receive 
a certificate that appears similar to what is described in that section, except that the 
"License Type" or "LicenseStyle" will be listed as "concurrent" instead of 
"nodelocked" and the "No. of Concurrent users" or "LicenseCount" fields should show 
the number of concurrent licenses that you ordered.

 Once LUM is successfully installed, configure the PC as a license server:



Note:  If the client PC is running Windows Vista or Windows 7, you may need 
Administrator elevated rights in order to proceed.   See   “Getting 
Administrator Rights” at the end of this document.

Click on Start > Programs > License Use Runtime and select Configuration 
Tool 

Configure as 

Select: 
Network 
License Server 

Direct Binding

Enter: 
hostname of 
server (must 
enter a name)
Select: <<Add 

Start up

Select: Start 
services at 
system startup 

Close window and save

Note: There is no exit button on the panel, you must close this panel to save 
changes.

 Start the Network License Server before continuing:

Start 

License Manager Tool 

Select: Service, then Start

 To add licenses, run the Basic License Tool: 

Start 

Basic Manager Tool 

The following default license will be displayed:
                                                          Available Enrolled
  Product                Version Vendor                    Licenses  Licenses
  LicensePower/iFOR test   1.0   LicensePower/ifor Test    10000     10000
  

Note: This test license is used by the i4tv utility when it is run on the clients to check 
for available servers. Do not delete it.

Add CCD concurrent licenses:



 Select Product

Enroll Product...

 The name of this server should appear in the "Server Name" field.
 Click on Import and select the file containing the License Certificate you received 

from IBM or DS. The program looks for files with .lic extensions. 
 You also have the option to manually enter the product, license and vendor 

information from the license file you ordered from IBM or DS. If you are going to 
use this method, display the file on a separate window and use cut/paste into the 
appropriate fields to avoid mistakes.

This completes the installation and customization of the LUM server software on Windows. 
Again, installing LUM on the clients is optional. The LUM configuration utility on the server 
created a file called "i4ls.ini" in the “C:\Documents and Settings\All Users\Application 
Data\IBM\LUM” directory. This file needs to be copied to the “C:\Documents and Settings\All 
Users\Application Data\IBM\LUM” directory on the client PCs. The CADAM Drafting license 
module will use the information in this file to locate the license server.  On Windows 7 or 
Vista the path to the i4ls.ini file is C:\ProgramData\IBM\LUM.

Optionally, you can install LUM on one client, which can later be used by the administrator to 
monitor license utilization and more. 

The following instructions cover the installation of LUM on the Windows client. 

 The network communication between the server and client must be operational in 
order to proceed. Make sure both machines can ping each other by hostname.

 The Windows installation file you previously downloaded from the IBM FTP Site is a 
self-extracting zipped file. Follow the README file instructions to install LUM on 
Windows. This is a very simple step. From File Manager or Explorer, just double-
click on arkwinxxx.exe. With newer releases of LUM, Install Shield starts. 
Otherwise, files are extracted into a temporary directory. If this is the case, go to 
this temp directory and Double-click on Setup to install LUM. By default, LUM is 
installed in the C:\ifor directory. 

Note: LUM must be installed on the same drive that the OS is installed on.

 Once LUM is installed, run the Configuration Tool to configure the client:

   Note:  If the client PC is running Windows Vista or Windows 7, you may need 
Administrator elevated rights in order to proceed.   See   “Getting 
Administrator Rights” at the end of this document.

Click on Start > Programs > License Use Runtime and select Configuration 
Tool Configuration Tool 

Configure as 

Select: Network License Client 

Direct Binding

Enter: hostname of server
Select: <<Add 

Close window and save



 Run the "LUM Test and Verification Tool" to verify that the client can find the 
server. From a DOS shell, run: \ifor\win\bin\i4tv

The response should look similar to this:

Note:  The CATIA products do not support Central Registry License Servers.  
Ignore the message “No servers found” returned by i4tv.

5. Concurrent Licensing with an HP-UX Server and HP-UX Clients

 Acquire your licenses and verify your HP-UX level 

o Identify the machine you will be using as a License Server. While logged in as 
superuser, run the command "uname -a" to get the machine's uname/target-
id.

o Order the CCD concurrent/server licenses from IBM. These licenses are based 
on the machine's uname.

o Verify that your server is running a supported version of HP-UX 10.20, 11.0 or 
11.i.

 Acquire the necessary LUM software

o IFOR/LS is the standard licensing mechanism that is supplied with HP-UX. 
iFOR/LS is not supported by CADAM Drafting, so you must obtain the LUM 
software as described at the beginning of this document.

 Disable iFOR/LS: 

o iFOR/LS (GR3.0.3) is a standard function in HP-UX and must be deactivated to 
use LUM. Perform the next few steps to deactivate iFOR/LS: 

Add the following lines to the "/etc/rc.config.d/ncs" file:

START_LLBD = 0
START-GLBD = 0

Add the following line to the "/etc/rc.config.d/iforls" file:

START_I4LMD=0 



Reboot the system.

 Install LUM: 

o Logon as super user.
o Untar the file arkhpux4xx.tar using the command "tar -xvf arkhpux4xx.tar"
o Refer to the README.ARK file, and perform the steps under "Installing the 

License Use Runtime Package."
o Set the PATH to include /var/lum and /opt/lum/ls/os/hpux/bin.

 Run the Configuration Utility (Note that, unless the LUM-JGUI is installed, the HP, 
SGI, and Sun versions of this utility use simple line commands).  The LUM-JGUI 
requires Java 1.3.0 (support for Java 1.3.1 and above starts with LUM 467).

o Start i4config.
o Select Network License Server.
o Select Direct binding, and follow the prompts to complete the configuration of 

the server.
o The i4ls.ini file in /opt/lum/ls/conf now contains the server information.
o If the server is not running, execute "i4cfg -start" to start the server.
o Execute i4blt with the following arguments to enroll the product:

i4blt -a -n server_name -v "'vendor name' vendor_id 
vendor_password" -p "product_name product_version 
product_password license_annotation"

The values to use for the arguments are given in the licensing information 
obtained in Step 1 of "Install and Configure an HPUX LUM License Server."

This completes the installation and customization of the LUM server software. The next step 
is to configure licensing on the HP-UX client.

 Configure the workstation client without installing LUM.  

a. Simply copy the i4ls.ini file created in step 5 above to the workstation’s 
/opt/lum/ls/conf.  Create this directory path if it does not exist.

b. Create a link to the location of the i4ls.ini file in /var/lum:  ln –s 
/opt/lum/ls/conf  /var/lum/conf

c. It’s important that the file permissions on this file and path is read to everyone.

 Perform Steps 2 and 4 given under "Install and Configure an HPUX LUM License 
Server" 

 Configure LUM as a network license client: 

o Start i4config. 
o Select Network License Client. 
o Select Direct Binding, and follow the prompts to complete the configuration of 

the client. 
o Verify that the client can find the server by running the command 

/var/lum/i4tv. 

6. Concurrent Offline Licensing

What is Concurrent Off-line licensing?

Concurrent offline licensing allows users to check out a concurrent license from a license server for a 
certain number of days and to use it on a computer not connected to the network.  For example, a 



laptop computer to be used temporarily at a remote site.  Concurrent offline licensing is available for 
the CATIA, CCD, ENOVIA DMU or DELMIA (or RADE) products.  This document will only address the 
requirements for CCD (CATIA CADAM Drafting).

When the concurrent offline license is reserved for use, a license is installed on a laptop connected to 
the network. For the duration of the reservation, the extracted license is considered as a nodelock 
license tied to the laptop. This license is called an offline nodelocked license. Once the offline 
nodelocked license has been installed on the laptop, the laptop can be disconnected from the 
network.

Once extracted, the license is no longer available from the license server. The license only becomes 
available once more to other users when one of the following occurs:

 The reservation period expires 
 The license is returned to the server from the laptop (end-users can return the license before 

the expiration date). 
 The maximum extraction duration is 30 days. License Use Management Runtime (LUM) 

administrators can reduce this duration.

If a free standard concurrent license and a free concurrent offline license exist for the same product, 
and an end-user requests a license for this product, the server will provide the standard concurrent 
license, so that the concurrent offline license remains available for extraction.

Offline licensing is not supported if you use the LUM HAL (High-Availability Licensing) feature.

Software prerequisites for the client and the license server.

License Server

 Concurrent offline licenses can be enrolled and administered only on a server running IBM 
License Use Management Runtime (LUM) Version 4.6.7 or above on either Windows or UNIX.  
LUM 4.6.8.12 is recommended.

 The machine running the license server does not require CCD to be installed.

Laptop

 CCD V5R16 or above.  
 Supported Windows platforms: Windows 2000 SP2 or Windows XP 
 The laptop does not require any IBM License Use Management Runtime software, but must be

configured as a LUM client 
 LUM driver “LUMDriver.sys” needs to be installed on the client. 

Procedure

Implementing concurrent offline licensing involves the following steps which should be performed in 
the following order:

 On the license server 
 Then on the laptop. 

On the License Server

1. Log onto the machine running the LUM license server as root (UNIX) or as administrator 
(Windows).
On Windows, you must belong to the Administrators group, or have the privileges assigned to 
the Administrators group. 



The following steps referring to starting and stopping existing LUM servers and migration 
tasks do not apply if you are installing LUM for the first time or on a different machine. 

2. If you have already installed a previous version of LUM, go to the LUM installation directory. 
3. Stop the license server using the command: 

i4cfg -stop

4. Back up the data on the LUM server. 

To do so, refer to the section "Using the Built-In Backup and Recovery Procedure" in "Chapter 
7. Hints and Tips" in the following manual: IBM License Use Management - Using License Use 
Management Runtime.

5. Install IBM License Use Management Runtime (LUM) Version 4.6.8.12. 
6. On Windows, perform the necessary license database migration steps.

Refer to the section "Installing after an Uninstallation", in section "Installing License Use 
Management Runtime on Windows" in "Chapter 3. Installing License Use Management 
Runtime" in the following manual: 
IBM License Use Management - Using License Use Management Runtime.

7. Migrate the concurrent network licenses into concurrent offline licenses. 

To do so, you need to copy the i4_offline_mig tool from the LUM CD-ROM. This purpose-built 
command migrate all concurrent licenses into concurrent offline licenses on the network 
license server.

Check the IBM Web-site for updates to this tool:

http://www-306.ibm.com/software/applications/plm/support/prodannounce.html#040123

An offline license is similar to a normal concurrent license because, even after migration, it 
can continue to be used as a normal concurrent license. Each time a new license is enrolled, 
and you want to use it as an offline license, you must use the same command again to 
migrate the license.

The tool is located in a folder named after the operating system you are using. Copy the tool 
into the same LUM installation directory from which you run your LUM commands (i4cfg, i4blt,
...). Change the execution rights on the executable file to make sure that you will be able to 
run the tool.

Then, run the following command to migrate the licenses:

i4_offline_mig

After migration, the licenses will remain available, once the server has been restarted.  

8. Restart the license server using the command: 

i4cfg –start

Run the Basic License Tool and you’ll notice that a padlock has been added to the product 
name:



To do so, you use the Basic License Tool. Run the following command to start the Basic 
License Tool GUI on UNIX:

i4blt

On Windows, go to Start > Programs > License Use Runtime and select Basic License Tool.

9. Use the Basic License Tool to set up the concurrent offline license authorization rules. 

The LUM administrator must set up rules to determine which users, groups of users and 
machines are authorized to extract an offline concurrent license, and under which conditions. 
For example, a password can be associated to each rule. By default, nobody is authorized to 
extract offline licenses.

At this point, refer to the following manual: IBM License Use Management - Using License Use 
Management Runtime Version 4.6.8.

In this manual the section: Scenario 15: Managing Concurrent-Offline Licenses, located in the 
chapter Administering License Use Management Runtime, explains how to manage the use of 
concurrent-offline licenses. This scenario shows you the different aspects involved in 
concurrent offline license management, for example: 

 Setting the maximum number of days a product can be reserved 
 Modifying authorization 
 Adding a password for the default authorization 
 Creating and modifying authorization records for a specific concurrent-offline license, 

allowing authorized users or groups of users to take the license 
 Displaying details about the offline users, etc. 

Once this phase has been completed, you are now ready to extract the offline licenses to the 
laptop.

On the Laptop



1. Check that your laptop is connected to the network. 
2. For CCD, if don’t already have a nodelock file in the following path, you must create the file 

with Notepad, then save it as an empty file.  The nodelock file must not have a file extension.  
If LUM is not installed on the laptop, you must also create the path:

C:\Ifor\Ls\Conf\Nodelock

Note:  If you currently have a nodelock file in “Documents and Settings\All Users\Application 
Data\IBM\LUM,” you must either rename it or copy it to the above directory.  Otherwise CCD 
will not work.

3. Check that you have write access to the folder containing the nodelock file and to the 
nodelock file itself.   

4. If LUM is installed make sure that the LUM client is correctly configured and points to the 
machine running the LUM  license server from which you are going to extract the license. 

5. If LUM is not installed you must have a copy of the license server’s i4ls.ini file in “Documents 
and Settings\All Users\Application Data\IBM\LUM.” 

6. If CATIA is installed on the laptop, select the Start->Programs->CATIA V5R15 (or 
ENOVIA_DMU_Navigator V5R15, or DELMIA V5R15)->Tools->Nodelock Key Management 
V5R15 command. 

7. If none of the above CATIA products are installed on the laptop and only CCD is installed, you 
can download the Nodelock Management tool from www.cadam.com.  Starting with CCD 
V516 and above, the tool can be found under $CCD_ROOT\License\Off-
line\NodelockLicenseManager. 

8. Using the Nodelock Key Management tool, select the File->Extract command. 

Note: If you get the message “License Not Added Driver not running,” STOP.  The LUM 
driver needs to be installed.

Copy LUMDriver.sys from the CATIA V5 release media to C:\Windows\system32\drivers (or 
where Windows is installed on the machine). Now, to start this driver you must run 
lumdevdi.exe, also available on the CATIA V5 release media.  This executable does not give 
any feedback.  The best indication that the driver is running is that you will see the following 
dialog box when selecting File > Extract.

The following dialog box appears, listing the concurrent offline licenses located on the license 
server:



You can select one or several licenses to extract.

Before you extract the license, you can reset the license duration to extract the license for a 
lower duration than the one authorized. To do so, click the appropriate field, then click it 
again and enter a new value (30 days maximum). 
In certain cases, you may attempt to set a value greater than the value registered for that 
license on the LUM server. You will be informed if this is the case, and must reset an 
appropriate value accordingly.

In our example, the CCD license will expire in 10 days.

If the LUM administrator sets a password, you must enter the password. Even if you select 
several licenses for extraction, there will still be only one password. After validation, the 
license(s) is(are) extracted.

You cannot extract a license if the same license already exists as a nodelock license (either 
standard nodelock or offline nodelock) and with the same serial number, if applicable.

Let's assume that you want to extract a license for CCD and one for the MD2 configuration 
which you have installed on your laptop. Note that you can extract several licenses if 
required. 

Select the CCD license. Then, click the Extract button. 

A message popup will confirm that the license was successfully extracted. You can then click 
the OK button in the message box. Once the license has been extracted, it is no longer 
available on the license server for network users. The new status of the license can be 
tracked on the license server using the Basic License Tool.

Extracting an offline license creates the nodelock file on your laptop, or updates it if it already 
exists. If you select the File->Read command, you will see the offline license for MD2:

Offline nodelock licenses are identified in blue when listed using the Nodelock Key 
Management tool. 



To test that you can use the license offline, disconnect the laptop from the network. 

Start a CCD session and confirm that no license errors are displayed and CCD is fully 
functional.

You can now use your license for the duration specified when it was extracted. 

Once that duration has expired, the license will no longer be available.

Return a license back to the license server.

1. Reconnect the laptop to the network, then make sure that the LUM client is correctly 
configured and access the machine running the LUM license server from which you checked 
out the license. 

2. Using the same Nodelock Key Management tool you used to extract the license, select the 
File->Restitute command. 

The license you extracted is listed in a dialog box:

Note: You can return more than one offline license. 

3. Select the license, then click the Restitute button. 

A message popup will confirm that the license was successfully returned. You can then click 
the OK button in the message box. Once the license has been returned, it becomes available 
once more on the license server for network users. 



The status of the license can be tracked on the license server using the LUM Basic License 
Tool. 

7. Some Useful LUM Basic License Tool commands

The following LUM server i4blt administrator commands are for HP-UX, IRIX and 
Solaris UNIX systems. These commands will also work with AIX and Windows, but 
since LUM provides a graphical user interface with these operating systems, the GUI is 
easier to use. On AIX, the LUM executables are located in the /var/ifor directory. On
Windows, the executables are in C:\ifor\Win\Bin.  On HP-UX, the executables are 
located in the /opt/lum/ls/os/hpux/bin directory.

To view the i4blt command syntax:

i4blt -h

In LUM releases prior to 4.5.8, if CCD terminated abnormally, the license server did 
not always release the license after the timeout period has elapsed. These licenses are 
referred to as "stale licenses" and are marked as being in use, even though the 
application is no longer using the license. To avoid running out of licenses, clean up 
these stale licenses by issuing the following command:

i4blt -C -n "server_name" –v "’Dassault Systemes’" -p 
"'CATIA.MECH V4 CCD WORKSTATIONS’"

Note: If there are spaces in the name, you must use single quotes within the double 
quotes. It is also a good idea to run this command this command once every hour 
from a cron job, until this problem is resolved.

Current versions of LUM automatically recycle these licenses.  

To get general information and the product time stamp (required to delete a license):

i4blt -lp -p "'CATIA.MECH V4 CCD WORKSTATIONS'" -i

The time stamp should be a number like: 921167059

To delete the product with the time stamp above:

i4blt -d -n server_name -v "'Dassault Systemes'" -p 
"'CATIA.MECH V4 CCD WORKSTATIONS' 410" -t 921167059

To add (enroll) the new license:

i4blt -a -n server_name -v "'Dassault Sytemes' 
5242378dbf8d.02.c0.09.c8.93.00.00.00 gdzq8hnsez8yw" -p 
"'CATIA.MECH V4 CCD WORKSTATIONS' 410 
y5xp56ccjeapjkgkt5wehkwabnsaaa"

To list all the products enrolled:

i4blt -lp

To enroll a product using a license certificate:

i4blt -a -n server_name -f certificate_name

8. Getting Administrator Rights on Vista or Windows 7

On Windows Vista or Windows 7, being logged on as a user that is a member of the 
Administrators group, is enough to install LUM, but may not have enough privilege to run some 



of the LUM runtime commands.  In this case you need to get the Administrator rights to the 
elevated mode.  

Open Start menu. 

Type the cmd command in the Search field. 

On Windows Vista press Enter.

On Windows 7:

Press Ctrl+Shift+Enter. User Account Control window appears. 

Click OK or Continue. 

    A new title with the prefix Administrator appears in the Command Prompt window. 

Your rights have been extended to the administrator level, which allows you to run License Use 



Management Runtime administrative commands. 

Note:  If you want to run the LUM’s Configuration Tool, type i4cfg and i4cfg -services for the 
Service Manager Tool in the Command Prompt window. 


